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How to use this Competency Based Learning Materials (CBLMs) 
 

The module, Performing Design to HTML contains training materials and activities for you to 

complete. These activities may be completed as part of structured classroom activities or you 

may be required you to work at your own pace. These activities will ask you to complete 

associated learning and practice activities in order to gain knowledge and skills you need to 

achieve the learning outcomes.  

1. Review the Learning Activity page to understand the sequence of learning activities 

you will undergo. This page will serve as your road map towards the achievement of 

competence.  

  

2. Read the Information Sheets. This will give you an understanding of the jobs or tasks 

you are going to learn how to do. Once you have finished reading the Information 

Sheets complete the questions in the Self-Check.  

  

3. Self-Checks are found after each Information Sheet.  Self-Checks are designed to help 

you know how you are progressing.  If you are unable to answer the questions in the 

Self-Check you will need to re-read the relevant Information Sheet. Once you have 

completed all the questions check your answers by reading the relevant Answer Keys 

found at the end of this module.  

  

4. Next move on to the Job Sheets. Job Sheets provide detailed information about how 

to do the job you are being trained in. Some Job Sheets will also have a series of 

Activity Sheets. These sheets have been designed to introduce you to the job step by 

step. This is where you will apply the new knowledge you gained by reading the 

Information Sheets. This is your opportunity to practise the job. You may need to 

practise the job or activity several times before you become competent.  

   

5. Specification sheets, specifying the details of the job to be performed will be provided 

where appropriate.  

  

6. A review of competency is provided on the last page to help remind if all the required 

assessment criteria have been met. This record is for your own information and 

guidance and is not an official record of competency  

  

When working though this Module always be aware of your safety and the safety of others in 

the training room. Should you require assistance or clarification please consult your trainer or 

facilitator.  

  

When you have satisfactorily completed all the Jobs and/or Activities outlined in this 

module, an assessment event will be scheduled to assess if you have achieved competency 

in the specified learning outcomes. You will then be ready to move onto the next Unit of 

Competency or Module  
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Module Content 
 

Unit Title: Perform Design to HTML 

Unit Code: OU- ICT-WD-04-L3-V1 

Module Title: Performing Design to HTML 

 

Module Descriptor: This module encompasses the necessary knowledge, skills, and attitudes 

(KAS) for establishing work to perform design to HTML. It specially includes creating graphic 

design objects, creating image slices, and using objects in HTML. 

 

Nominal Hours: 40 

 

Learning Outcomes: 
 

Upon completion of this module the trainees will be able to:  
 

1. Create graphic design objects.  

2. Create an image slice.  

3. Use objects to HTML. 

 

Assessment Criteria: 

 

1. Image processing software is identified.  

2. Basic shape is created.  

3. Image manipulation is performed. 

4. Web UI (User Interface) is created. 

5. Graphic design object is identified. 

6. Image processing software is selected.  

7. Smart objects vs normal layers are introduced.  

8. Layers are used. 

9. Objects are sliced. 

10. Objects are exported for the web.  

11. Graphic assets are integrated to the webpage.  
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Learning Outcome 1: Create graphic design objects 
 

Assessment Criteria 

 

1. Image processing software is identified.  

2. Basic shape is created.  

3. Image manipulation is performed. 

4. Web UI (User Interface) is created. 

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

 
Contents 

1 Image Processing Software 

2 Basic Shapes 

3 Image Manipulation 

4 Web User Interfaces (UI) 

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

1. Written Test 

2. Demonstration 

3. Oral Questioning   
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Learning Experience 1: Create graphic design objects 

 

You must perform the learning steps below to achieve the objectives stated in this learning 

guide. Beside each step are the resources or special instructions you will use to accomplish the 

corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Students will ask the 

instructor about perform 

design to HTML. 

1. The instructor will provide the learning materials for` 

Create graphic design objects. 

2. Read the Information sheet/s 
2. Information Sheet No 1: Create graphic design 

objects.  

3. Complete the Self-Checks & 

Answer key sheets. 

3. Self-Check No 1: Create graphic design objects.   

 

Answer key No 1: Create graphic design objects. 

 

4. Read the Job/ Task sheet and 

Specification Sheet  

4. Job/ task sheet and specification sheet  

 

▪ Job Sheet No 1: Enhancing Visual Elements for Web 

Interface.   

 

▪ Specification Sheet 1: Enhancing Visual Elements for 

Web Interface. 
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Information Sheet 1: Create graphic design objects 
 

Learning Objective: 

 

After completion of this information sheet, the learners will be able to explain, define and 

interpret the following contents: 

 

1.1 Image Processing Software 

1.2 Basic Shapes 

1.3 Image Manipulation 

1.4 Web User Interfaces (UI) 

 

1.1 Image Processing Software 

 

There is various image processing software available, both commercial and open-

source, that can be used for a wide range of image editing and manipulation tasks.  

Here are some popular examples: 

 

1.1.1 Adobe Photoshop:   

Photoshop is a renowned image 

processing software developed by Adobe 

Systems. It is widely used by 

professionals and enthusiasts in various 

fields such as photography, graphic 

design, digital art, and web design. 

Photoshop offers a comprehensive set of 

tools and features that allow users to 

manipulate, enhance, and transform 

digital images.  

 

 

Here are some key aspects and functionalities of Photoshop: 

 

▪ Image Editing: Photoshop provides a range of editing tools that enable users to 

modify images in numerous ways. These tools include cropping, resizing, rotating, and 

straightening. Users can also adjust brightness, contrast, saturation, and color balance 

to enhance the overall appearance of an image. 

▪ Layers and Masks: Photoshop employs a layered approach, allowing users to work 

with multiple layers of content. Layers provide flexibility and non-destructive editing, 

enabling users to modify specific elements without affecting the entire image. 

Additionally, masks are used to control the visibility of specific parts of a layer or to 

apply selective edits. 
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▪ Selection Tools: Photoshop offers a variety of selection tools to isolate and manipulate 

specific areas within an image. These tools include marquee, lasso, quick selection, 

and magic wand tools. Users can select and edit specific portions of an image, apply 

adjustments, or perform advanced editing techniques. 

▪ Retouching and Healing: Photoshop includes powerful retouching and healing tools 

for removing imperfections, blemishes, and unwanted objects from images. The Spot 

Healing Brush, Clone Stamp, and Content-Aware Fill are among the tools that enable 

users to seamlessly remove or replace elements within an image. 

▪ Filters and Effects: Photoshop provides an extensive collection of filters and effects 

that allow users to apply creative enhancements and transformations to images. These 

filters can alter the image's appearance by adding textures, adjusting lighting and color 

effects, creating blurs, and simulating various artistic styles. 

 

▪ Text and Typography: Users can add text and manipulate typography within 

Photoshop. It offers a wide range of fonts, formatting options, and text effects to create 

visually appealing designs, logos, and graphics. 

▪ Image File Formats: Photoshop supports a broad range of image file formats, 

including JPEG, PNG, GIF, TIFF, PSD (native Photoshop format), and more. It allows 

users to export images in various formats suitable for different purposes, such as web 

publishing, printing, or sharing on social media. 

Overall, Photoshop is a versatile and powerful image processing software that provides 

an extensive array of tools and features for editing, retouching, manipulating, and 

enhancing digital images. Its capabilities have made it an industry standard for 

professionals working in visual arts and design. 

1.1.2 GIMP (GNU Image Manipulation 

Program): GIMP, which stands for 

GNU Image Manipulation Program, is a 

popular open-source image processing 

software. It is available for free and is 

widely used by photographers, graphic 

designers, and digital artists as an 

alternative to proprietary software like 

Photoshop. GIMP offers a wide range of 

tools and features that allow users to 

edit, retouch, and enhance digital 

images.  

 

Here are some key aspects and functionalities of GIMP: 

 

▪ Image Editing: GIMP provides a comprehensive set of editing tools for adjusting and 

modifying images. Users can crop, resize, rotate, and flip images to achieve the desired 
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composition. Additionally, GIMP offers various tools for adjusting colors, levels, 

brightness, contrast, and saturation to enhance image quality. 

▪ Layers and Masks: Similar to Photoshop, GIMP utilizes a layered approach that 

allows users to work with multiple layers of content. Layers enable non-destructive 

editing and offer flexibility in managing different elements within an image. GIMP 

also supports layer masks, which allow users to control the visibility and transparency 

of specific areas of a layer. 

▪ Selection Tools: GIMP provides a variety of selection tools for isolating and 

manipulating specific parts of an image. These tools include rectangular and elliptical 

selections, freehand selections, and the intelligent foreground extraction tool. Users 

can refine selections, apply adjustments, or perform advanced editing techniques on 

selected areas. 

▪ Retouching and Healing: GIMP offers retouching and healing tools to remove 

imperfections, blemishes, and unwanted elements from images. Tools like the Healing 

Brush and Clone Tool allow users to clone or replace parts of an image seamlessly. 

GIMP also includes the Resynthesizer plugin, which enables content-aware fill and 

texture synthesis. 

▪ Filters and Effects: GIMP provides a wide range of filters and effects that can be 

applied to images. These include artistic filters, blur effects, noise reduction, 

sharpening tools, and distortion effects. Users can also create custom filters and apply 

various layer blending modes to achieve unique visual effects. 

▪ Text and Typography: GIMP allows users to add text to images and offers various 

tools for typography. Users can choose from a range of fonts, adjust text size, color, 

and alignment, and apply effects such as drop shadows and outlines. GIMP also 

supports text editing in a separate text editor window, providing flexibility and control 

over text manipulation. 

▪ Image File Formats: GIMP supports a wide range of image file formats, including 

JPEG, PNG, GIF, TIFF, PSD, and more. It also supports exporting images in various 

formats suitable for web publishing, printing, or sharing on social media platforms. 

 

Overall, GIMP is a powerful and versatile image processing software that provides a 

robust set of tools and features for editing, retouching, and enhancing digital images. 

Its open-source nature makes it accessible to a broad user community, and its 

functionality is continually expanded through the contributions of developers and 

users alike. 
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1.1.3 Adobe Lightroom: Adobe Lightroom is 

a comprehensive image processing 

software specifically designed for 

photographers and photography 

enthusiasts. It is part of the Adobe 

Creative Cloud suite and offers a range 

of powerful tools and features to 

manage, edit, and enhance digital 

images efficiently.   

Here are some key aspects and functionalities of Adobe Lightroom: 

 

▪ Image Organization: Lightroom provides advanced tools for organizing and 

managing large collections of photos. Users can import images into catalogs, create 

folders, and assign keywords, ratings, and flags to easily search and filter images. 

Lightroom also offers features like collections and smart collections for better 

organization and grouping of images. 

▪ Non-Destructive Editing: One of the standout features of Lightroom is its non-

destructive editing capability. It means that the original image file remains untouched, 

and all edits and adjustments are saved as metadata, allowing users to revert back to 

the original state at any time. This provides flexibility and preserves image quality 

throughout the editing process. 

▪ Develop Module: Lightroom's Develop module is the core editing workspace, 

offering a wide range of adjustment tools for enhancing images. Users can make 

precise adjustments to exposure, contrast, highlights, shadows, white balance, and 

other parameters. The module also provides tools for cropping, straightening, and 

correcting lens distortions. 

▪ Presets and Profiles: Lightroom includes a vast library of presets and profiles that 

allow users to apply predefined looks and effects to their images with a single click. 

Presets can simulate film styles, black and white conversions, vintage effects, and 

more. Users can also create and save their own presets for quick and consistent editing. 

▪ Local Adjustments: Lightroom provides robust tools for making selective 

adjustments to specific areas of an image. Users can use the Graduated Filter, Radial 

Filter, and Adjustment Brush to apply localized edits such as exposure, clarity, 

saturation, and color adjustments. This enables precise control over different parts of 

the image. 

▪ Integration with Photoshop: Lightroom seamlessly integrates with Adobe 

Photoshop, allowing users to send images to Photoshop for advanced retouching and 

compositing work. Edits made in Photoshop can be saved and synchronized back to 
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Lightroom, maintaining a smooth and non-destructive editing workflow between the 

two applications. 

▪ Syncing and Mobile Support: Lightroom offers cloud syncing capabilities, allowing 

users to access their photos and edits across multiple devices. The Lightroom mobile 

app provides a streamlined version of the software for smartphones and tablets, 

enabling users to edit, organize, and share their photos on the go. 

▪ Image Export and Publishing: Lightroom provides various options for exporting 

images in different file formats, sizes, and quality settings. Users can also directly 

publish images to popular social media platforms, websites, or create custom export 

presets to streamline their publishing workflow. 

 

Adobe Lightroom is widely regarded as a powerful and efficient image processing 

software for photographers. Its intuitive interface, extensive editing tools, and 

seamless integration with other Adobe Creative Cloud applications make it a preferred 

choice for professionals and enthusiasts looking to enhance and manage their digital 

image collections. 

1.1.4 Capture One: Capture One is a 

professional-grade image processing 

software developed by Phase One. It is 

primarily used by photographers and 

offers advanced tools and features for 

organizing, editing, and enhancing 

digital images. Capture One is known 

for its robust raw image processing 

capabilities and is widely regarded as a 

top choice among professional 

photographers.  

 

Here are some key aspects and functionalities of Capture One: 

 

▪ Raw Image Processing: Capture One excels in processing raw image files, offering 

exceptional control over the conversion process. It provides precise tools for adjusting 

exposure, contrast, color balance, white balance, and other image parameters specific 

to raw files. Capture One's algorithms and profiles ensure accurate color rendering and 

detail retention in raw image processing. 

▪ Catalogs and Sessions: Capture One allows users to manage their image libraries 

through catalogs or sessions. Catalogs are comprehensive databases that can handle 

large collections, while sessions provide a folder-based approach for tethered shooting 

or smaller projects. Both options offer powerful organization tools, such as star ratings, 

keywords, and metadata editing, to streamline image management. 
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▪ Image Editing: Capture One provides an extensive range of editing tools to refine and 

enhance images. Users can make precise adjustments to exposure, contrast, highlights, 

shadows, curves, and color grading. Additionally, localized adjustment tools like the 

Brush, Gradient Mask, and Healing Brush allow for selective edits on specific areas 

of the image. 

▪ Layers and Masks: Capture One features a flexible layer system that enables users to 

work with multiple layers of adjustments and modifications. Layers can be used to 

apply different adjustments to specific areas of an image, allowing for non-destructive 

editing and precise control over the final result. Layer masks further enhance the 

ability to target and isolate adjustments. 

▪ Tethered Shooting: Capture One is widely used for tethered shooting, where the 

camera is connected to a computer, allowing for real-time image capture and transfer. 

It provides a seamless and reliable workflow for professional photographers, enabling 

them to preview, evaluate, and adjust images on a larger screen while shooting. 

▪ Styles and Presets: Capture One offers a variety of styles and presets to apply 

predefined looks and effects to images. These styles can simulate film stocks, create 

black and white conversions, and apply artistic effects. Users can also create and save 

their own styles and presets for consistent editing and efficient workflow. 

▪ Export and Publishing: Capture One provides a range of options for exporting 

images in various formats, sizes, and quality settings. It also offers direct publishing 

to popular social media platforms and integrates with professional printing services, 

making it convenient for photographers to showcase and share their work. 

 

Capture One is renowned for its exceptional image quality, robust feature set, and 

dedicated support for a wide range of camera models. It is a preferred choice for 

professional photographers who require precise control over image processing and 

advanced editing capabilities. 

1.1.5 Affinity Photo: Affinity Photo is a powerful 

image processing software developed by 

Serif. It is designed to meet the needs of 

photographers, graphic designers, and digital 

artists, offering a comprehensive set of tools 

and features for editing, retouching, and 

enhancing digital images.  
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Here are some key aspects and functionalities of Affinity Photo: 

 

▪ User Interface: Affinity Photo provides a clean and intuitive user interface that allows 

users to navigate the software and access tools and features with ease. The interface is 

customizable, enabling users to arrange panels and toolbars according to their 

preferences. 

▪ Non-Destructive Editing: Affinity Photo employs a non-destructive editing 

workflow, preserving the original image data while allowing users to make 

adjustments and modifications. Users can create adjustment layers, masks, and live 

filter layers to apply changes without permanently altering the original image. 

▪ Selection Tools: Affinity Photo offers a range of selection tools for isolating and 

manipulating specific areas of an image. These tools include marquee, lasso, magnetic 

selection, and quick selection tools. Users can refine selections with the selection 

refinement feature, enabling precise edits on selected areas. 

▪ Layers and Masks: Affinity Photo supports layers and masks, allowing users to work 

with multiple layers of content. Layers offer flexibility in editing specific elements of 

an image, while masks enable users to control the visibility and transparency of 

different areas within a layer. 

▪ Retouching and Healing: Affinity Photo provides a variety of retouching and healing 

tools for removing imperfections, blemishes, and unwanted objects from images. 

Tools like the Healing Brush, Clone Brush, and Inpainting Brush allow users to 

seamlessly remove or replace elements within an image. 

▪ Filters and Effects: Affinity Photo offers a wide range of filters and effects to apply 

creative enhancements and transformations to images. Users can apply adjustments 

for brightness, contrast, levels, curves, and more. Affinity Photo also provides 

numerous artistic filters, blurs, and distortions to achieve unique visual effects. 

▪ RAW Editing: Affinity Photo has robust support for working with RAW files. It offers 

advanced RAW processing capabilities with options to adjust exposure, white balance, 

noise reduction, lens corrections, and more. Users can process and develop RAW files 

with precision and control. 

▪ Typography and Text Editing: Affinity Photo allows users to add and manipulate 

text within their images. Users have access to a variety of text tools, including the 

ability to adjust fonts, sizes, colors, alignments, and apply text effects. Advanced 

typography features like character and paragraph styles enhance text editing 

capabilities. 

▪ File Format Compatibility: Affinity Photo supports various image file formats, 

including JPEG, PNG, TIFF, PSD, and RAW formats from different camera 

manufacturers. It also offers export options to save images in different formats suitable 

for web, print, and other purposes. 

 



 

13 
 

Affinity Photo is known for its affordability, powerful feature set, and smooth 

performance. It provides professional-grade image processing capabilities and has 

gained popularity among photographers, designers, and digital artists as a robust 

alternative to other image processing software. 

1.1.6 Adobe Adobe Illustrator: Adobe 

Illustrator is a popular vector-based 

image processing software developed by 

Adobe Systems. It is widely used by 

designers, illustrators, and artists to 

create and manipulate scalable vector 

graphics. Illustrator offers a range of 

tools and features that allow users to 

create precise and visually appealing 

artwork, logos, typography, and 

illustrations.  

 

 

Here are some key aspects and functionalities of Adobe Illustrator: 

 

▪ Vector Graphics: Illustrator is primarily focused on vector graphics, which use 

mathematical equations to define shapes and objects. This allows for infinite 

scalability without loss of quality. Users can create and edit paths, anchor points, and 

curves to create smooth and precise shapes and lines. 

▪ Drawing and Illustration Tools: Illustrator provides a comprehensive set of drawing 

tools, including the Pen tool, Pencil tool, Shape tools, and the Blob Brush tool. These 

tools enable users to create and manipulate paths, freehand drawings, geometric 

shapes, and brush strokes. 

▪ Typography and Text Editing: Illustrator offers extensive typography features, 

allowing users to create and manipulate text. Users can choose from a wide range of 

fonts, adjust font size, spacing, and alignment, and apply effects such as outlines, 

shadows, and gradients to text. Advanced typography controls provide precise control 

over kerning, tracking, and other text attributes. 

▪ Precision and Alignment: Illustrator provides tools for precise alignment, 

positioning, and measurement. Users can align objects, distribute them evenly, and 

apply numeric transformations. The smart guides and grid systems help in accurately 

placing and aligning objects within the artwork. 

▪ Layers and Masks: Illustrator supports a layered approach, allowing users to work 

with multiple layers of content. Layers provide organization and flexibility in 

managing different elements of the artwork. Users can also use masks to control the 

visibility and editability of specific parts of a layer or group. 
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▪ Image Tracing and Live Paint: Illustrator offers an Image Trace feature that can 

convert raster images into editable vector artwork. This allows users to transform 

photographs and other raster images into scalable vector graphics. The Live Paint 

feature enables users to apply colors and fills to objects and create complex color 

combinations. 

▪ Effects and Filters: Illustrator provides a wide range of effects and filters to enhance 

artwork. Users can apply transformations, distortions, blends, gradients, and various 

artistic and stylization effects to create unique visual effects. The Appearance panel 

allows users to stack multiple effects and adjust their parameters. 

▪ Export and Integration: Illustrator supports various file formats for exporting 

artwork, including SVG, PDF, EPS, and AI (native Illustrator format). Users can 

export artwork for web, print, or integration with other Adobe Creative Cloud 

applications like Photoshop and InDesign. 

 

Adobe Illustrator is a powerful software for creating and editing vector-based graphics. 

Its precise drawing tools, typography capabilities, and extensive range of effects make 

it a go-to tool for designers and illustrators working on projects that require scalable 

and high-quality artwork. 

1.1.7 Adobe InDesign: Adobe InDesign is a 

professional desktop publishing 

software developed by Adobe Systems. 

It is widely used by graphic designers, 

publishers, and marketing professionals 

to create and layout various types of 

print and digital publications. InDesign 

provides a comprehensive set of tools 

and features that enable users to design, 

format, and publish visually appealing 

and interactive content.  

 

 

Here are some key aspects and functionalities of Adobe InDesign: 

 

▪ Layout and Page Design: InDesign offers a flexible and intuitive interface for 

designing layouts and arranging content on pages. Users can create multi-page 

documents, set up master pages for consistent design elements, and easily manage the 

flow of text and images across different pages. 

▪ Typography and Text Editing: InDesign provides robust typography features, 

allowing users to work with text effectively. Users can apply a wide range of fonts, 

adjust font sizes, leading, tracking, and other text attributes. Advanced typographic 

controls enable precise control over text formatting, alignment, and hyphenation. 
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▪ Images and Graphics: InDesign supports the integration of images and graphics into 

layouts. Users can import images, resize and crop them, adjust their positioning, and 

apply effects. InDesign also provides tools for creating and editing vector graphics, 

including shapes, paths, and custom illustrations. 

▪ Styles and Templates: InDesign offers style and template features that streamline the 

design process and ensure consistency throughout a publication. Users can create and 

apply paragraph styles, character styles, and object styles, making it easy to maintain 

consistent formatting across different sections and pages. Templates allow users to 

create reusable layouts and design elements for efficiency and consistency. 

▪ Interactive Elements: InDesign enables the creation of interactive and multimedia 

content for digital publications. Users can add hyperlinks, buttons, interactive 

navigation, audio, video, and animation effects to enhance the interactivity of digital 

documents and eBooks. 

▪ Prepress and Output: InDesign provides prepress tools and features to prepare 

documents for print production. Users can define bleed, set up color profiles, manage 

transparency, and export high-resolution print-ready PDF files. InDesign also supports 

the integration with Adobe Acrobat for advanced PDF editing and preflighting. 

▪ Integration with Adobe Creative Cloud: InDesign seamlessly integrates with other 

Adobe Creative Cloud applications, such as Photoshop and Illustrator. This allows 

users to import and edit images and graphics directly within InDesign, leveraging the 

power and functionality of the other Adobe applications. 

▪ Collaboration and Sharing: InDesign offers collaboration features, such as the 

ability to track changes, add comments, and share documents with team members for 

review. Users can also package files, including fonts and images, for easy sharing and 

handoff to print or production vendors. 

 

Adobe InDesign is a versatile and powerful software for designing and publishing a 

wide range of print and digital content. Its extensive set of tools and features, combined 

with its integration with other Adobe Creative Cloud applications, makes it a go-to 

choose for professionals working on projects like magazines, brochures, newsletters, 

eBooks, and interactive documents. 
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1.1.8 Adobe XD: Adobe XD (Experience 

Design) is a powerful image 

processing software specifically 

designed for creating and prototyping 

user interfaces (UI) and user 

experiences (UX) for websites, mobile 

apps, and other digital platforms. It 

allows designers and UX professionals 

to efficiently design, prototype, and 

share interactive and engaging 

experiences. 
 

Here are some key aspects and functionalities of Adobe XD: 

 

▪ Artboard-based Design: Adobe XD uses an artboard-based approach, where 

designers work on individual screens or pages of a digital project. Users can create 

multiple artboards to represent different screens and interactions, enabling them to 

design and connect various UI elements seamlessly. 

▪ UI Design Tools: Adobe XD provides a rich set of design tools for creating visually 

appealing user interfaces. Users can draw shapes, import images and icons, apply color 

and gradients, and use vector-based tools to create custom graphics and illustrations. 

Text tools allow precise control over typography, including font selection, size, 

spacing, and alignment. 

▪ Prototyping and Interactions: Adobe XD offers powerful prototyping features that 

allow designers to create interactive experiences. Users can define and link artboards 

to create transitions, gestures, and animations, simulating the user journey and 

interactions. Interactive elements like buttons, menus, and overlays can be easily 

added to create a realistic user experience. 

▪ Responsive Design: Adobe XD supports responsive design, enabling designers to 

create designs that adapt to different screen sizes and orientations. Users can define 

layouts, grids, and constraints to ensure that UI elements respond and adjust 

dynamically to different device sizes and resolutions. 

▪ Component and Style Libraries: Adobe XD allows users to create and manage 

design components and styles for efficient and consistent design. Users can create 

reusable components such as buttons, menus, and cards, and update them globally 

across the project. Shared styles ensure consistency in typography, colors, and other 

design attributes. 
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▪ Collaboration and Feedback: Adobe XD offers collaboration features that allow 

designers to share their designs with stakeholders and receive feedback. Users can 

share prototypes and design specifications with others, enabling them to review and 

provide comments directly within the XD interface. Real-time collaboration is also 

possible, allowing multiple users to work on the same project simultaneously. 

▪ Integration with Design Systems: Adobe XD integrates with design systems and 

external tools, making it a versatile software for design workflows. Users can import 

and integrate design assets from other Adobe Creative Cloud applications like 

Photoshop and Illustrator. Additionally, Adobe XD supports integration with other 

design tools and platforms through plugins and extensions. 

▪ Developer Handoff: Adobe XD provides features for developer handoff, making it 

easier for designers to collaborate with developers. Users can generate design 

specifications and assets, including CSS code, color codes, and image assets, to 

facilitate the development process and ensure accurate implementation of the design. 

 

Adobe XD is a comprehensive and user-friendly software for designing and 

prototyping user interfaces and experiences. Its intuitive interface, powerful design 

tools, and seamless integration with other Adobe Creative Cloud applications make it 

a preferred choice for UI/UX designers and teams working on digital projects. 

 

1.2 Basic Shapes 

 

To create basic shapes in Adobe Photoshop, you can use the shape tools available in the 

toolbar. Here's a step-by-step guide to creating some of the shapes you mentioned: 

1.2.1 Circle: 

 

To create a basic circle shape in 

Adobe Photoshop, you can follow 

these steps: 

 

 

▪ Open Adobe Photoshop and create a new document or open an existing one where you 

want to create the circle shape. 

▪ Select the "Ellipse Tool" from the toolbar. It is usually located under the "Shape Tool" 

group, which can be accessed by clicking and holding the shape tool icon. 
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▪ With the "Ellipse Tool" selected, go to the options bar at the top of the Photoshop 

interface. Make sure the "Shape" option is selected, as it allows you to create a vector-

based shape. 

 

▪ In the options bar, you can set the fill and stroke color for your circle. Click on the color 

swatch next to "Fill" and "Stroke" to choose the desired colors. You can also adjust the 

stroke width if necessary. 
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▪ Now, click and drag on the canvas while holding the Shift key. This will constrain the 

shape to a perfect circle. Dragging from the center outward will create a circle of the 

desired size. 

▪ Release the mouse button to create the circle shape. You can reposition and resize the 

circle by clicking and dragging its edges or by using the transform controls that appear 

around the shape. 

 

▪ Once you are satisfied with the circle's position and size, you can further customize it 

using various Photoshop tools and effects. For example, you can apply gradients, 

shadows, or textures to the circle shape. 
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▪ If you want to modify the shape later, you can select the "Path Selection Tool" from the 

toolbar and click on the circle shape. This will allow you to move, resize, or make any 

necessary adjustments to the shape. 

 

▪ To convert the circle shape into a rasterized layer, right-click on the shape layer in the 

Layers panel and select "Rasterize Layer." This will convert the vector shape into a 

regular pixel-based layer, allowing you to apply additional effects or edits if desired. 

 

Remember, these steps specifically apply to Adobe Photoshop, and the process may vary 

slightly in other image processing software. 
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1.2.2 Triangle: 

 

To create a triangle shape in Adobe Photoshop, you can follow these steps: 

 

 

▪ Open Adobe Photoshop and create a new document or open an existing one where you 

want to create the triangle shape. 

▪ Select the "Polygon Tool" from the toolbar. It is usually located under the "Shape Tool" 

group, which can be accessed by clicking and holding the shape tool icon. 

▪ With the "Polygon Tool" selected, go to the options bar at the top of the Photoshop 

interface. In the "Sides" field, enter "3" to indicate that you want to create a triangle. 

▪ In the options bar, you can set the fill and stroke color for your triangle. Click on the 

color swatch next to "Fill" and "Stroke" to choose the desired colors. You can also adjust 

the stroke width if necessary. 

▪ Now, click and drag on the canvas to define the base of the triangle. Release the mouse 

button to create the triangle shape. You can reposition and resize the triangle by clicking 

and dragging its edges or by using the transform controls that appear around the shape. 

▪ Once you are satisfied with the triangle's position and size, you can further customize it 

using various Photoshop tools and effects. For example, you can apply gradients, 

shadows, or textures to the triangle shape. 

▪ If you want to modify the shape later, you can select the "Path Selection Tool" from the 

toolbar and click on the triangle shape. This will allow you to move, resize, or make any 

necessary adjustments to the shape. 

▪ To convert the triangle shape into a rasterized layer, right-click on the shape layer in the 

Layers panel and select "Rasterize Layer." This will convert the vector shape into a 

regular pixel-based layer, allowing you to apply additional effects or edits if desired. 

 

Remember, these steps specifically apply to Adobe Photoshop, and the process may vary 

slightly in other image processing software. 

1.2.3 Square/Rectangle: 

To create a square or rectangle shape in Adobe Photoshop, you can follow these 

steps: 
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▪ Open Adobe Photoshop and create a new document or open an existing one where you 

want to create the square or rectangle shape. 

 

 
▪ Select the "Rectangle Tool" from the toolbar. It is usually located under the "Shape Tool" 

group, which can be accessed by clicking and holding the shape tool icon. 

 

 
▪ With the "Rectangle Tool" selected, go to the options bar at the top of the Photoshop 

interface. Make sure the "Shape" option is selected, as it allows you to create a vector-

based shape. 
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▪ In the options bar, you can set the fill and stroke color for your square or rectangle. Click 

on the color swatch next to "Fill" and "Stroke" to choose the desired colors. You can 

also adjust the stroke width if necessary. 

▪ Now, click and drag on the canvas while holding the Shift key to create a perfect square. 

To create a rectangle, click and drag without holding the Shift key. Dragging from the 

center outward will create a square or rectangle of the desired size. 

 
▪ Release the mouse button to create the square or rectangle shape. You can reposition 

and resize the shape by clicking and dragging its edges or by using the transform 

controls that appear around the shape. 
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▪ Once you are satisfied with the square or rectangle's position and size, you can further 

customize it using various Photoshop tools and effects. For example, you can apply 

gradients, shadows, or textures to the shape. 

▪ If you want to modify the shape later, you can select the "Path Selection Tool" from the 

toolbar and click on the shape. This will allow you to move, resize, or make any 

necessary adjustments to the shape. 

▪ To convert the square or rectangle shape into a rasterized layer, right-click on the shape 

layer in the Layers panel and select "Rasterize Layer." This will convert the vector shape 

into a regular pixel-based layer, allowing you to apply additional effects or edits if 

desired. 

Remember, these steps specifically apply to Adobe Photoshop, and the process may vary 

slightly in other image processing software. 

 

1.2.4 Rhombus/Trapezoid/Pe

ntagon/Hexagon/Octagon: 

To create various polygon 

shapes like a rhombus, 

trapezoid, pentagon, hexagon, or 

octagon in Adobe Photoshop, 

you can follow these steps: 

 
 

▪ Open Adobe Photoshop and create a new document or open an existing one where you 

want to create the polygon shape. 

▪ Select the "Polygon Tool" from the toolbar. It is usually located under the "Shape Tool" 

group, which can be accessed by clicking and holding the shape tool icon. 
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▪ With the "Polygon Tool" selected, go to the options bar at the top of the Photoshop 

interface. In the "Sides" field, enter the desired number of sides for the polygon you 

want to create (e.g., 4 for a rhombus or trapezoid, 5 for a pentagon, 6 for a hexagon, or 

8 for an octagon). 

▪ In the options bar, you can set the fill and stroke color for your polygon. Click on the 

color swatch next to "Fill" and "Stroke" to choose the desired colors. You can also adjust 

the stroke width if necessary. 

▪ Now, click and drag on the canvas to create the polygon shape. Holding the Shift key 

while dragging will constrain the proportions of the shape, ensuring it remains 

symmetric. 

▪ Release the mouse button to create the polygon shape. You can reposition and resize the 

shape by clicking and dragging its edges or by using the transform controls that appear 

around the shape. 

▪ Once you are satisfied with the polygon's position and size, you can further customize 

it using various Photoshop tools and effects. For example, you can apply gradients, 

shadows, or textures to the shape. 

▪ If you want to modify the shape later, you can select the "Path Selection Tool" from the 

toolbar and click on the shape. This will allow you to move, resize, or make any 

necessary adjustments to the shape. 

▪ To convert the polygon shape into a rasterized layer, right-click on the shape layer in 

the Layers panel and select "Rasterize Layer." This will convert the vector shape into a 

regular pixel-based layer, allowing you to apply additional effects or edits if desired. 

Remember, these steps specifically apply to Adobe Photoshop, and the process may vary 

slightly in other image processing software. 

1.2.5 Pyramid: 

Creating a pyramid shape in Adobe Photoshop involves using the Polygon Tool and 

transforming it into a 3D perspective. Here's a step-by-step guide: 

 

▪ Open Adobe Photoshop and create a new document or open an existing one where you 

want to create the pyramid shape. 
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▪ Select the "Polygon Tool" from the toolbar. It is usually located under the "Shape Tool" 

group, which can be accessed by clicking and holding the shape tool icon. 

▪ With the "Polygon Tool" selected, go to the options bar at the top of the Photoshop 

interface. Set the number of sides to 4, as a pyramid has a square base. 

▪ In the options bar, you can set the fill and stroke color for your pyramid. Click on the 

color swatch next to "Fill" and "Stroke" to choose the desired colors. You can also adjust 

the stroke width if necessary. 

▪ Now, click and drag on the canvas while holding the Shift key to create a perfect square 

shape for the base of the pyramid. 

▪ Release the mouse button to create the square shape. You can reposition and resize the 

shape by clicking and dragging its edges or by using the transform controls that appear 

around the shape. 

▪ Next, go to the "Edit" menu and select "Transform" > "Perspective." This will allow you 

to adjust the shape into a 3D perspective. 

▪ Click and drag the bottom handles of the transform box inward to converge the sides of 

the square towards the top, creating the pyramid shape. Adjust the perspective until you 

achieve the desired look. 

▪ Press Enter or click the checkmark icon in the options bar to apply the perspective 

transformation. 

▪ Once you are satisfied with the pyramid's shape and perspective, you can further 

customize it using various Photoshop tools and effects. For example, you can apply 

gradients, shadows, or textures to the shape to add depth and realism. 

▪ If you want to modify the shape later, you can select the "Path Selection Tool" from the 

toolbar and click on the pyramid shape. This will allow you to move, resize, or make 

any necessary adjustments to the shape. 

▪ To convert the pyramid shape into a rasterized layer, right-click on the shape layer in 

the Layers panel and select "Rasterize Layer." This will convert the vector shape into a 

regular pixel-based layer, allowing you to apply additional effects or edits if desired. 

Remember, these steps specifically apply to Adobe Photoshop, and the process may vary 
slightly in other image processing software. 

1.2.6 Oval: 

 

To create an oval shape in Adobe 

Photoshop, you can follow these 

steps: 

  

▪ Open Adobe Photoshop and create a new document or open an existing one where you 

want to create the oval shape. 

▪ Select the "Ellipse Tool" from the toolbar. It is usually located under the "Shape Tool" 

group, which can be accessed by clicking and holding the shape tool icon. 
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▪ With the "Ellipse Tool" selected, go to the options bar at the top of the Photoshop 

interface. Make sure the "Shape" option is selected, as it allows you to create a vector-

based shape. 

▪ In the options bar, you can set the fill and stroke color for your oval. Click on the color 

swatch next to "Fill" and "Stroke" to choose the desired colors. You can also adjust the 

stroke width if necessary. 

▪ Now, click and drag on the canvas to define the oval shape. By default, holding the Shift 

key while dragging will constrain the shape to a perfect circle. If you want to create an 

oval shape, simply click and drag without holding the Shift key. Dragging from the 

center outward will create the oval of the desired size. 

▪ Release the mouse button to create the oval shape. You can reposition and resize the 

shape by clicking and dragging its edges or by using the transform controls that appear 

around the shape. 

▪ Once you are satisfied with the oval's position and size, you can further customize it 

using various Photoshop tools and effects. For example, you can apply gradients, 

shadows, or textures to the oval shape. 

▪ If you want to modify the shape later, you can select the "Path Selection Tool" from the 

toolbar and click on the oval shape. This will allow you to move, resize, or make any 

necessary adjustments to the shape. 

▪ To convert the oval shape into a rasterized layer, right-click on the shape layer in the 

Layers panel and select "Rasterize Layer." This will convert the vector shape into a 

regular pixel-based layer, allowing you to apply additional effects or edits if desired. 

 

Remember to adjust the fill and stroke properties in the Options bar to change the color, 

stroke width, and other attributes of the shapes. 

 

These instructions should help you get started with creating basic shapes in Adobe 

Photoshop. 

 

1.3 Image Manipulation 

 

Performing image manipulation in Adobe Photoshop involves various techniques and 

tools to achieve desired results. Here's a breakdown of common image manipulation 

tasks: 
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1.3.1 Image Resize: 

 

▪ Open the image in Photoshop. 

▪ Go to the "Image" menu and select "Image Size." 

▪ In the dialog box, you can adjust the dimensions of the image by entering specific 

values or using percentage scaling. 

▪ Make sure the "Resample" option is checked to maintain image quality while 

resizing. 

▪ Click "OK" to apply the changes. 

1.3.2 Color Correction: 

 

▪ Open the image in Photoshop. 

▪ Utilize adjustment layers to modify the image's color balance, brightness, contrast, 

and saturation. 

▪ Go to the "Layer" menu and select "New Adjustment Layer," then choose the 

adjustment you want to make (e.g., "Levels," "Curves," "Hue/Saturation," etc.). 

▪ Adjust the sliders or curves in the adjustment layer properties panel to achieve the 

desired color correction. 

▪ Experiment with different adjustments until you achieve the desired result. 
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1.3.3 Retouch: 

 

▪ Use retouching tools like the "Spot 

Healing Brush," "Healing Brush," or 

"Clone Stamp" tool to remove 

imperfections or enhance certain 

areas. 

▪ Select the desired retouching tool 

from the toolbar. 

▪ Adjust the brush size, hardness, and 

opacity in the options bar according 

to your needs. 

▪ Alt-click (Option-click on Mac) on a 

clean area near the imperfection to 

sample it as a source. 

▪ Click and brush over the imperfection 

or area you want to retouch, blending 

it with the surrounding pixels. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Original Image Final Result 
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1.3.4 Crop: 

 

▪ Open the image in Photoshop. 

▪ Select the Crop Tool from the toolbar (shortcut: C). 

▪ Click and drag to define the desired crop area on the image. 

▪ Adjust the crop area by dragging the handles or entering specific values in the options 

bar. 

▪ Press Enter (Return on Mac) or click the checkmark in the options bar to apply the 

crop. 

 

 

1.3.5 Filter: 

 

▪ Open the image in Photoshop. 

▪ Go to the "Filter" menu and explore the various filter options available. 

▪ Select a filter category and choose a specific filter to apply. 

▪ Adjust the filter settings if necessary to achieve the desired effect. 

▪ Click "OK" to apply the filter. 

1.3.6 Optimize for Web: 

 

▪ Open the image in Photoshop. 

▪ Go to the "File" menu and select "Export" or "Save for Web" (depending on your 

Photoshop version). 

▪ In the Export/Save for Web dialog box, adjust the settings to optimize the image for 

web use. 

▪ Set the desired file format (JPEG, PNG, GIF), quality, resolution, and image size. 

▪ Preview the optimized image and make any necessary adjustments. 

▪ Click "Save" or "Export" to save the optimized image. 

 

These are some common image manipulation tasks in Adobe Photoshop. Experimenting with 

different tools and techniques will help you develop your skills further. 

 

 

 

 

 

 

 

Selecting the Crop Tool. 
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1.4 Web User Interfaces (UI): 

 

Creating web user interfaces (UI) involves combining design principles, visual 

elements, and interactive components to develop an appealing and user-friendly 

interface. Here are some steps to help you create a web UI: 

 

1.4.1 Define the project scope: 

 

▪ Understand the purpose of the website or web application and its target audience. 

▪ Identify key features and functionalities that the UI needs to support. 

 

1.4.2 Conduct research and gather inspiration: 

 

▪ Explore existing websites or UI design galleries to gather inspiration. 

▪ Research industry trends, best practices, and user preferences to inform your design 

decisions. 

 

1.4.3 Plan the structure and layout: 

 

▪ Create a sitemap or wireframe to visualize the hierarchical structure and organization 

of the interface. 

▪ Define the layout of key components, such as header, navigation, content sections, 

sidebars, and footer. 

 

 

1.4.4 Design the visual elements: 

 

▪ Select an appropriate color scheme that aligns with the brand or project requirements. 

▪ Choose fonts that are legible and consistent with the design style. 

▪ Create a visual hierarchy by using contrast, sizing, and spacing to guide users' 

attention. 
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▪ Design buttons, icons, forms, and other UI elements to ensure clarity and ease of use. 

 

 
  

1.4.5 Create responsive design: 

 

▪ Consider different devices and screen sizes by incorporating responsive design 

principles. 

▪ Design flexible layouts and elements that adapt to various screen resolutions. 

 
1.4.6 Develop interactive components: 

 

▪ Design and implement navigation menus, buttons, forms, and other interactive 

elements. 

▪ Ensure intuitive user interactions through appropriate feedback, such as hover 

effects, animations, or transitions. 

 

1.4.7 Prototype and iterate: 

 

▪ Use prototyping tools like Adobe XD, Figma, or InVision to create interactive 

prototypes. 

▪ Test the prototype with users to gather feedback and identify areas for improvement. 

▪ Iterate on the design based on user feedback, making necessary adjustments and 

refinements. 
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1.4.8 Collaborate with developers: 

 

▪ Provide design specifications, style guides, and assets to developers for 

implementation. 

▪ Maintain clear communication with the development team to address any design-

related issues during implementation. 

 

1.4.9 Test and refine: 

 

▪ Conduct usability testing to evaluate the effectiveness of the UI design. 

▪ Gather user feedback and make iterative improvements based on the test results. 

▪ Continuously monitor and refine the UI based on user feedback and analytics data. 

 

Remember, creating a successful web UI involves balancing aesthetics with usability. 

Prioritize user-centered design principles and strive for a visually appealing, intuitive, and 

efficient interface that meets the needs of your target audience. 
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Self-Check Sheet 1: Create graphic design objects 
 

1. Name a popular image processing software.  

Answer:  

 

2. What is the purpose of image processing software?  

Answer:  

 

3. How can you create a rectangle shape in image processing software?  

Answer:  

  

4. What is the process of adjusting image brightness and contrast called?  

Answer: 

  

5. Which file format supports transparent backgrounds in images?  

Answer:  

  

6. What is the primary goal of web UI design?  

Answer: 

  

7. How can you ensure a consistent color scheme in web UI design?  

Answer:  

 

8. What is the purpose of wireframing in web UI design?  

Answer:  

  

9. How can you optimize images for the web?  

Answer:  

  

10. What is the process of combining multiple images into one called?  

Answer:  
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Answer Key 1: Create graphic design objects 
 

 

1. Name a popular image processing software.  

Answer: Adobe Photoshop 

 

2. What is the purpose of image processing software?  

Answer: To edit, enhance, and manipulate digital images 

 

3. How can you create a rectangle shape in image processing software?  

Answer: Using the Rectangle Tool 

  

4. What is the process of adjusting image brightness and contrast called?  

      Answer: Image enhancement 

  

5. Which file format supports transparent backgrounds in images?  

Answer: PNG (Portable Network Graphics) 

  

6. What is the primary goal of web UI design?  

Answer: To create visually appealing and user-friendly interfaces for websites 

  

7. How can you ensure a consistent color scheme in web UI design?  

Answer: By using a predefined color palette or following branding guidelines 

 

8. What is the purpose of wireframing in web UI design?  

Answer: To create a basic layout and structure of a web page or interface 

  

9. How can you optimize images for the web?  

Answer: By reducing file sizes, choosing appropriate formats, and resizing images 

  

10. What is the process of combining multiple images into one called?  

Answer: Image compositing. 
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Job Sheet 1: Enhance Visual Elements for Web Interface 

 

Job Name: Enhance Visual Elements for Web Interface 

Procedure: 

1. Creating Basic Shapes 

• Open the chosen image processing software. 

• Familiarize yourself with the shape tools available (e.g., Rectangle, Circle, 

Polygon). 

• Use the shape tools to create basic shapes like squares, circles, and triangles. 

• Experiment with different sizes, colors, and positions for each shape. 

• Save the final image with the created shapes. 
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Specification Sheet- 1: Create graphic design objects 
 

Necessary tools and equipment 
 

Sl. No Name of Tools & Equipment Specification Unit Quantity 

1  Computer 
Minimum Corei3 with 

4GB RAM 
Set 01 

2  
Web Browser (e.g., Google 

Chrome) 
Latest Version No. 01 

3  Internet connections  High Speed Set 01 

4  

Image processing software 

(e.g., Adobe Photoshop, 

GIMP) 

Latest Version No. 1 

 

Other Specifications: Sample image (Identify different Elements and build them) 
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Learning Outcome 2: Create an image slice 
 

Assessment Criteria 

 

1. Graphic design object is identified. 

2. Image processing software is selected.  

3. Smart objects vs normal layers are introduced.  

4. Layers are used. 

5. Objects are sliced 

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

 

Contents 

1 Graphic Design Objects 

2 Image Processing Software 

3 Smart Objects Vs Normal Layers 

4 Working with Layers 

5 Slicing Objects for Web Optimization 

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

1. Written Test 

2. Demonstration 

3. Oral Questioning   
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Learning Experience 2: Create an image slice 

 

You must perform the learning steps below to achieve the objectives stated in this learning 

guide. Beside each step are the resources or special instructions you will use to accomplish the 

corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Students will ask the 

instructor about perform 

design to HTML 

1. The instructor will provide the learning materials for` 

Create an image slice. 

2. Read the Information sheet/s 2. Information Sheet No 2: Create an image slice. 

3. Complete the Self-Checks & 

Answer key sheets. 

3. Self-Check No 2: Create an image slice  

 

Answer key No 2: Create an image slice 

 

4. Read the Job/ Task sheet and 

Specification Sheet  

4. Job/ task sheet and specification sheet  

 

▪ Job Sheet No 2: Perform image manipulation 

 

▪ Specification Sheet 2: Perform image 

manipulation 
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Information Sheet 2: Create an image slice 
 

Learning Objective: 
 

After completion of this information sheet, the learners will be able to explain, define and 

interpret the following contents: 
 

2.1 Graphic Design Objects 

2.2 Image Processing Software 

2.3 Smart Objects Vs Normal Layers 

2.4 Working with Layers 

2.5 Slicing Objects for Web Optimization 

 

2.1 Graphic Design Objects: 

To identify graphic design objects, you can follow these steps: 

▪ Understand the context: Familiarize yourself with the design project or brief to 

understand the design's purpose and goals. This will help you identify relevant graphic 

design objects. 

▪ Analyze the design: Take a closer look at the design composition and elements. Look for 

distinct shapes, lines, colors, and patterns. 

▪ Identify typography: Examine the text elements in the design. Note the text's typefaces, 

font styles, sizes, and hierarchy. Typography plays a crucial role in graphic design. 

▪ Recognize imagery: Identify any photographic images, illustrations, or icons used in the 

design. Consider their subject matter, style, and how they contribute to the overall message. 

▪ Pay attention to logos and branding: Look for logos or branding elements, such as 

company logos, trademarks, or specific brand colors and symbols. These elements often 

serve as key identifiers in a design. 

▪ Notice graphical elements: Observe elements like shapes, lines, and patterns. They can 

be abstract or representational, adding visual interest and structure to the design. 

▪ Evaluate composition: Assess the design's overall layout and arrangement of elements. 

Note the use of grids, alignment, balance, and proximity to create a visually pleasing 

composition. 

▪ Consider visual hierarchy: Identify the visual hierarchy in the design. Notice which 

elements are emphasized, such as headings, subheadings, or important information, and 

how they are differentiated from less prominent elements. 

▪ Examine color usage: Pay attention to the color palette used in the design. Note the 

dominant colors, complementary colors, and any color schemes or gradients employed to 

convey a specific mood or enhance visual appeal. 

▪ Look for interactive elements: If the design includes interactive components, such as 

buttons, navigation menus, or user interface elements, identify them and consider their 

functionality. 

By following these steps and analyzing the various elements within a design, you can 

effectively identify graphic design objects. This understanding will help you appreciate the 
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design's composition and make informed assessments and decisions when working with or 

evaluating graphic designs. 

2.2 Image Processing Software 

 

Image processing software empowers users with various tools and functionalities to edit, 

enhance, and transform digital images, offering unparalleled creative freedom and 

possibilities. From basic adjustments like cropping, resizing, and color correction to 

advanced features such as layer-based editing, filters, and special effects, these software 

solutions cater to a wide range of user requirements and skill levels. 

 

The image-processing software market offers many options, from industry-leading 

commercial software to free and open-source alternatives. By understanding the unique 

features and strengths of various software solutions, users can confidently select the one 

that best aligns with their specific needs, enabling them to achieve remarkable results and 

elevate the visual impact of their digital imagery. 

 

When selecting image processing software, several factors should be considered based on 

your specific needs and requirements. Here are some key considerations to help you 

choose the right image-processing software: 

 

Scenario: You are a professional photographer looking for image processing software to 

edit and enhance your photos for personal projects and client work. 
 

▪ Purpose: Determine the purpose of the software. In this case, you need software for 

professional image editing and enhancement. 

▪ Features: Consider the features you require. You need tools for basic editing (cropping, 

resizing, exposure adjustments), advanced retouching, color correction, filters, and support 

for RAW files. 

▪ Ease of use: As a professional, you are willing to invest time in learning the software, but 

you also value an intuitive interface and smooth workflow. 

▪ Compatibility: Check if the software is compatible with your operating system (e.g., 

Windows or macOS). Additionally, see if it integrates well with your preferred file 

management and organization software. 

▪ Performance and speed: Look for software that can handle high-resolution images 

efficiently and performs tasks quickly without excessive lag or slowdowns. 

▪ Support and documentation: Ensure that the software offers comprehensive 

documentation, tutorials, and user forums to assist you when needed. Prompt customer 

support is also valuable in case you encounter any issues. 

▪ Cost: Consider your budget. While you are willing to invest in professional-grade 

software, it should offer good value for money and align with your budgetary constraints. 
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▪ Industry-specific needs: Although a photographer, you may not have specific industry 

requirements beyond standard image editing capabilities. 

▪ Reputation and reviews: Research the reputation of various software options. Look for 

reviews from professional photographers or trusted sources to understand their experiences 

and satisfaction levels. 

▪ Trial and experimentation: Take advantage of trial versions or demos of shortlisted 

software options. Spend time experimenting with the tools, editing different types of 

photos, and evaluating how well the software aligns with your workflow and preferences. 

Example software: Adobe Photoshop Based on the example scenario, Adobe Photoshop 

would be a suitable software option. Here's how it matches the considerations: 

▪ Purpose: Adobe Photoshop is widely used for professional image editing and offers a wide 

range of features. 

▪ Features: Photoshop provides a comprehensive set of tools for editing, retouching, color 

correction, filters, and RAW file support. 

▪ Ease of use: While Photoshop has a learning curve, its user interface is well-organized and 

offers customizable workspaces. 

▪ Compatibility: Photoshop is available for both Windows and macOS and integrates well 

with Adobe Bridge for file management. 

▪ Performance and speed: Photoshop are known for its efficient performance, even with 

large image files and complex operations. 

▪ Support and documentation: Adobe offers extensive documentation, tutorials, and a 

large user community. Their customer support is generally prompt and reliable. 

▪ Cost: Photoshop is a premium software with subscription-based pricing, but it provides 

excellent value for professional photographers. 

▪ Industry-specific needs: Photoshop is widely used in the photography industry and offers 

features tailored to photographers' needs. 

▪ Reputation and reviews: Adobe Photoshop have a strong reputation and is highly 

regarded by professional photographers. 

▪ Trial and experimentation: Adobe offer a free trial of Photoshop, allowing you to explore 

its features and evaluate its suitability for your needs. 

Remember, while Adobe Photoshop is a popular choice, there are other image processing 

software options available, such as Capture One, Affinity Photo, or Lightroom, that may also 

meet your requirements. Be sure to compare them based on the considerations mentioned 

earlier and choose the one that best aligns with your specific needs and preferences. 
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2.3 Smart Objects Vs Normal Layers: 

 

Understanding the difference between smart objects and normal layers is essential for 

efficient and flexible image editing. Let's delve into their definitions and characteristics: 

 

Normal Layers: Normal layers in image editing software, such as Adobe Photoshop, 

are the fundamental building blocks of compositions. Each layer consists of visual 

content that can be edited independently of other layers. They can contain various 

elements like images, text, shapes, or adjustments. 

 

 

Key points about normal layers: 

▪ Independent Editing: Normal layers allow you to apply different 

transformations, blending modes, opacity adjustments, and layer-specific 

effects. 

▪ Pixel-Based: The content within a normal layer is rasterized, meaning it's 

composed of pixels. Scaling or resizing can result in a loss of image quality. 

▪ Editing Limitations: Once you apply a transformation or effect directly to a 

normal layer, it becomes permanent and can't be easily modified without 

using tools like masks or adjustment layers. 

Smart Objects: Smart objects, on the other hand, are special types of layers that retain 

the original source content and allow for non-destructive editing. A smart object can be 

a raster image, vector graphic, or even a nested composition. 

Key points about smart objects: 

▪ Source File Preservation: Smart objects link to the original source file or 

embed it within the layer. This preserves the original data, including 

resolution and vector information. 

▪ Non-Destructive Editing: Smart objects enable non-destructive 

transformations and adjustments. You can scale, rotate, apply filters, or add 

effects without permanently altering the original data. 
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▪ Editability: You can double-click on a smart object to open it as a separate 

document, make edits, and save changes. These edits will automatically 

update in all instances of the smart object in your composition. 

▪ Lossless Scaling: Smart objects can be resized multiple times without losing 

quality because the transformations are recalculated based on the original 

source. 

▪ Filter and Adjustment Flexibility: Smart objects allow you to apply filters, 

adjustment layers, and layer styles that can be modified or removed at any 

time. 

▪ File Size Considerations: Since smart objects retain the original source data, 

they may increase file size compared to normal layers. 

Benefits of Smart Objects: 

▪ Preservation of image quality during scaling and transformations. 

▪ Non-destructive editing, making it easier to experiment and revert changes. 

▪ Reusability and efficiency when using the same source file in multiple 

compositions. 

▪ Integration with external software like Adobe Illustrator, where vector 

graphics can be converted into smart objects for seamless editing. 

 

In summary, normal layers are pixel-based and provide direct editing capabilities, while 

smart objects maintain a link to the original source content, allowing for non-destructive 

editing and scalability. Smart objects offer greater flexibility, editability, and 

preservation of image quality, making them advantageous in many scenarios, 

particularly for complex compositions or when working with external files. 

2.4 Working with Layers 

 

Working with layers in Adobe Photoshop is fundamental for creating complex and non-

destructive image compositions. Layers allow you to stack, organize, and edit different 

elements of your design or photograph independently. Here's a step-by-step guide on 

working with layers in Photoshop: 
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2.4.1 Creating Layers: 

 

▪ To create a new layer, go to the Layers panel (usually located on the right side of the 

interface) and click on the "Create a new layer" button at the bottom. Alternatively, 

you can use the shortcut Shift+Ctrl+N (Shift+Cmd+N on a Mac). 

▪ You can also create a new layer by duplicating an existing layer. Select the layer you 

want to duplicate and press Ctrl+J (Cmd+J on a Mac). 

2.4.2 Layer Ordering: 

 

▪ Arrange the layers in the desired order by clicking and dragging them up or down 

within the Layers panel. The layers at the top appear in front of the layers below. 

2.4.3 Layer Visibility: 

 

▪ Toggle the visibility of a layer by clicking the eye icon next to it in the Layers panel. 

This allows you to show or hide specific layers to view the impact on the overall 

composition. 

2.4.4 Layer Opacity: 

 

▪ Adjust the opacity of a layer to control its transparency. Use the Opacity slider in the 

Layers panel or enter a specific value to make the layer more or less transparent. 

Lower opacity values make the layer more see-through. 

2.4.5 Layer Blending Modes: 

 

▪ Blending modes control how a layer interacts with the layers below it. Select a layer 

and experiment with different blending modes from the drop-down menu in the 

Layers panel to achieve different visual effects. 

2.4.6 Layer Masks: 

 

▪ Layer masks enable selective editing by hiding or revealing portions of a layer. To 

add a layer mask, select the layer and click on the "Add layer mask" button at the 

bottom of the Layers panel. You can then use brushes or selection tools to paint on 

the mask to hide or reveal parts of the layer. 

 

2.4.7 Adjustment Layers: 

 

▪ Adjustment layers allow you to apply non-destructive edits to your image. Click on 

the "Create new fill or adjustment layer" button at the bottom of the Layers panel 

and select the desired adjustment (e.g., Levels, Curves, Hue/Saturation). These 
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adjustment layers affect all the layers below them and can be modified or removed 

at any time. 

2.4.8 Grouping Layers: 

 

▪ Grouping layers helps organize and manage complex compositions. Select the layers 

you want to group (hold Shift and click on the layers) and press Ctrl+G (Cmd+G on 

a Mac) or click on the "Create a new group" button at the bottom of the Layers panel. 

You can then collapse or expand the group to hide or show its contents. 

2.4.9 Layer Styles: 

 

▪ Layer styles provide additional effects like drop shadows, gradients, strokes, and 

more. Double-click on a layer to open the Layer Style dialog box, or right-click on a 

layer and choose "Blending Options" to access various styling options. 

2.4.10 Smart Objects: 

 

▪ Convert layers to smart objects to maintain non-destructive editing capabilities and 

preserve the original source content. Right-click on a layer and select "Convert to 

Smart Object" or go to the Layer menu and choose "Smart Objects." 

 

By understanding and utilizing these layer-related features, you can take full advantage 

of Photoshop's flexibility, allowing you to create intricate designs, composite multiple 

images, and easily adjust without permanently altering your original content. 

2.5 Slicing Objects for Web Optimization 

 

Slicing objects for web optimization involves dividing an image or design into smaller, 

optimized sections called slices. This technique is commonly used to improve web page 

loading times and optimize file sizes. 
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Here's a step-by-step guide on slicing objects for web optimization in Adobe Photoshop: 
 

▪ Open your image or design file in Photoshop. 

▪ Select the Slice Tool: In the toolbar, click and hold on the Crop Tool (or press C) to 

reveal the hidden Slice Tool. Click on the Slice Tool to activate it. 

▪ Define the Slices: 

▪ Automatic Slicing: With the Slice Tool selected, go to the options bar at the top. Choose 

"Auto Slice" to automatically divide the image into slices based on certain criteria like 

equal size or guidelines. 

Manual Slicing: To define slices, click and drag the Slice Tool across the area you want to slice. 

Hold Shift while dragging to create square slices. 

2.5.1 Adjust Slice Properties 
 

You can adjust properties like URL links, alternative text, and optimization settings for 

each slice. Select a slice and modify its properties in the Slice Options panel (usually 

located below the Layers panel). Specify a destination URL, add alt text for 

accessibility, and choose optimization settings. 
 

2.5.2 Export Slices 
 

▪ To export the slices, go to File > Export > Save for Web (Legacy) or use the shortcut 

Alt+Shift+Ctrl+S (Option+Shift+Cmd+S on a Mac). 

▪ Select the desired file format in the Save for Web dialog box (e.g., JPEG, PNG, GIF). 

▪ Adjust the optimization settings to balance file size and image quality. Consider factors 

like color palette, dithering, and compression. You can preview the output in real time 

and compare different settings. 

▪ Specify the destination folder and file name and click "Save" to export the sliced 

images. 

2.5.3 HTML Generation (Optional) 
 

If you want to generate HTML code for the sliced image, you can do so in the Save for 

Web dialog box. Click on the "Save" button, and in the next dialog, select "HTML and 

Images" from the "Save as type" dropdown. This creates an HTML file with the code 

to display the sliced image on a webpage. 
 

2.5.4 Implement the Sliced Image: 

 

▪ Once you have the sliced and optimized images, you can incorporate them into your 

webpage or design. Use the HTML code generated or manually insert the optimized 

image slices, ensuring they link to the appropriate URLs and contain alt text if 

applicable. 

By slicing objects and optimizing individual sections, you can achieve faster loading times and 

reduce bandwidth usage on web pages. It's important to strike a balance between file size and 

image quality to ensure a smooth user experience. Regularly test and optimize your slices to 

achieve the best results for your specific web project. 
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Self-Check Sheet 2: Create an image slice 

1. Which of the following is a graphic design object?       

a) Pixel   b) Layer   c) Filter   d) Brush 

2. What is the purpose of image processing software?  

a) Editing text in images    b) Creating 3D models  

c) Manipulating and enhancing images  d) Designing web layouts 

3. Smart objects in image processing software:  

a) Are non-editable and raster-based  

b) Allow for non-destructive editing and scaling without loss of quality  

c) Are used only for text editing  

d) Can be directly exported to web formats 

4. Which option best describes a normal layer?  

a) Allows for non-destructive editing  

b) Supports vector graphics only  

c) Cannot be rearranged within the layer stack  

d) Offers advanced 3D modeling features 

5. What is the purpose of working with layers in image processing software?  

a) To organize and manage different elements of an image  

b) To apply filters and effects  

c) To adjust the image resolution  

d) To optimize images for web loading 

6. Which of the following is a common technique for slicing objects for web optimization?  

a) Cropping     b) Resizing    

c) Cloning     d) Dividing an image into smaller parts 
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7. When slicing objects for web optimization, what is the purpose of creating separate slices?  

a) To reduce image file size  

b) To apply filters and effects to individual slices  

c) To merge them into a single image file  

d) To convert them into vector graphics 

8. Which file format is commonly used for exporting sliced images for the web?  

a) JPEG   b) TIFF   c) GIF    d) SVG 

9. Which of the following is a consideration when selecting image processing software? a) 

Price and availability    

b) Compatibility with specific operating systems  

c) Range of supported file formats  

d) All of the above 

10. What is the main advantage of using smart objects over normal layers?  

a) They allow for non-destructive editing  

b) They have a smaller file size  

c) They support 3D modeling features  

d) They offer advanced text editing capabilities 
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Answer Key 2: Create an image slice 
 

 

Answer 

1. Answer: b) Layer 

2. Answer: c) Manipulating and enhancing images 

3. Answer: b) Allow for non-destructive editing and scaling without loss of quality  

4. Answer: c) Cannot be rearranged within the layer stack  

5. Answer: a) To organize and manage different elements of an image  

6. Answer: d) Dividing an image into smaller parts:  

7. Answer: a) To reduce image file size:  

8. Answer: a) JPEG:  

9. Answer: d) All of the above  

10. Answer: a) They allow for non-destructive editing:  
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Job Sheet 2: Perform Image Manipulation 

Procedure: 

 

1. Select an image to work with (you can use a sample image or your own). 

2. Open the image in the image processing software. 

3. Explore the various image manipulation tools (e.g., crop, resize, adjust 

brightness/contrast) and selection tools (e.g., marquee, lasso) to define areas that need 

to be sliced. 

4. Create Layer via Cut: Cut the selected area and paste it as a new layer.  

5. Organize the sliced elements into separate layers for easy management. 

6. Use descriptive names for each layer to ensure clarity during slicing. 

7. Save the manipulated image with a new name to preserve the original. 
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Specification Sheet- 2: Create an image slice 

 
Necessary tools and equipment 

 

Sl. 

No 
Name of Tools & Equipment Specification Unit Quantity 

1 Computer 
Minimum Corei3 

with 4GB RAM 
Set 01 

2 Web Browser (e.g., Google Chrome) Latest Version No. 01 

3 Internet connections  High Speed Set 01 

4 
Image processing software (e.g., 

Adobe Photoshop, GIMP) 
Latest Version No. 1 

5 
Design software (e.g., Adobe XD, 

Figma, Sketch) 
Latest Version No. 1 

 

Other Specifications: Sample image (below) and elements (Use the work from Job Sheet 1) 

 

1. Slicing Areas: Banner Section, Logo, Person Image, Call-to-Action Button. 

2. Layers: Banner_Slice, Logo_Slice, Person_Slice, CTA_Button_Slice 

3. Export Settings: 

- Banner_Slice: JPEG format, quality 80, 1920x600 pixels. 

- Logo_Slice: PNG format, transparent background, 300x150 pixels. 

- Person_Slice: JPEG format, quality 90, 800x800 pixels. 

- CTA_Button_Slice: PNG format, transparent background, 200x50 pixels 
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Learning Outcome 3: Use objects to HTML 
 

Assessment Criteria 

 

1. Objects are exported for web 

2. Graphic assets are integrated to webpage 

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

 
Contents 

1 Objects for the Web 

2 Graphic Assets into Webpages 

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

1. Written Test 

2. Demonstration 

3. Oral Questioning   
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Learning Experience 3: Use objects to HTML 

 

You must perform the learning steps below to achieve the objectives stated in this learning 

guide. Beside each step are the resources or special instructions you will use to accomplish the 

corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Students will ask the 

instructor about perform 

design to HTML 

1. The instructor will provide the learning materials for` 

use objects to HTML 

2. Read the Information 

sheet/s 

2. Information Sheet No: use objects to HTML 

3. Complete the Self-Checks & 

Answer key sheets. 

3. Self-Check No 3: Use objects to HTML 

 

Answer key No 3: Use objects to HTML 

 

4. Read the Job/ Task sheet 

and Specification Sheet  

4. Job/ task sheet and specification sheet  

 

Job Sheet No 3: Use objects to HTML to build a 

website 

 

Specification Sheet 3: Use objects to HTML to build 

a website 
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Information Sheet 3: Use objects to HTML 
 

Learning Objective: 

 

After completion of this information sheet, the learners will be able to explain, define and 

interpret the following contents: 

 

3.1 Objects for the Web. 

3.2 Graphic Assets into Webpages. 

3.1 Objects for the Web 

Exporting objects for the web 

involves saving individual 

elements from a design or image 

in a format optimized for web 

use. This allows for faster 

loading times and better 

compatibility across different 

browsers and devices.  

 

 

Here's a step-by-step guide on exporting objects for the web using Adobe Photoshop: 

▪ Open your image or design file in Photoshop. 

▪ Select the Object to Export: Use the selection tools (e.g., Marquee, Lasso, or Magic 

Wand) to select the specific object or element you want to export. Ensure that your 

selection encompasses only the desired object and doesn't include any unwanted 

parts. 

▪ Refine the Selection (Optional): Use Photoshop's selection tools or refine edge 

techniques (e.g., Select and Mask) to fine-tune the selection edges for smoother 

results. 

▪ Create a New Document (Optional): If the object you want to export is part of a 

larger composition and you wish to isolate it on a transparent background, create a 

new document with a transparent background before proceeding to the next steps. 

Use the "File" menu and select "New" to create a new document with the desired 

dimensions and a transparent background. 

▪ Copy and Paste: With the object or element selected, copy it by pressing Ctrl+C 

(Cmd+C on a Mac). Then, paste it into the new document or an existing one by 

pressing Ctrl+V (Cmd+V on a Mac). 
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▪ Position and Resize (if necessary): Adjust the position and size of the pasted object 

within the document using the Move Tool (V). You can also use the Transform 

options (Ctrl+T or Cmd+T) to resize, rotate, or scale the object as needed. 

▪ Export the Object: 

➢ Go to File > Export > Export As (or "Save for Web" in older Photoshop 

versions) or use the shortcut Ctrl+Shift+Alt+S (Cmd+Shift+Option+S on a 

Mac). 

➢ In the export dialog box, choose the desired format for the object, such as 

JPEG, PNG, or GIF, based on your specific needs. 

➢ Adjust the settings according to the format you selected. For example, for 

JPEG, you can adjust the quality slider to balance image quality and file size. 

For PNG, you can choose transparency options. 

➢ Specify the destination folder and file name for the exported object. 

➢ Click "Export" or "Save" to save the object in the desired format and location. 

▪ Repeat for Additional Objects: If you have multiple objects to export, repeat the 

steps above for each individual object, selecting, copying, and pasting them into 

separate documents or as separate layers within the same document. 

▪ Implement the Exported Objects: Once the objects are exported, you can use them 

in your web projects by incorporating them into your HTML and CSS code or using 

them in design software or web development tools. 

 

Remember to consider the appropriate file formats and settings for different types of objects, 

such as photographs, illustrations, icons, or logos, to achieve the best balance between image 

quality and file size for optimal web performance. 

 
3.2 Graphic Assets into Webpages 

 

Integrating graphic assets into webpages involves incorporating visual elements like 

images, icons, logos, and illustrations into your HTML and CSS code to enhance the 

design and user experience. Here's a step-by-step guide on how to integrate graphic 

assets into webpages: 

▪ Prepare your Graphic Assets: 

➢ Ensure your graphic assets are appropriately sized, optimized, and in a web-

friendly format (e.g., JPEG, PNG, SVG). 
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➢ If necessary, consider optimizing images for web use by reducing file size 

without compromising image quality using tools like Adobe Photoshop or 

online image compression services. 

▪ File Organization: 

➢ Create a dedicated folder within your project directory to store all your 

graphic assets. 

➢ Organize your assets into subfolders based on categories or sections to 

maintain a well-structured file hierarchy. 

▪ HTML Markup: 

➢ Open your HTML file in a text editor or web development tool. 

➢ Identify the location within your HTML code where you want to integrate the 

graphic asset (e.g., within a specific HTML element like <div>, <img>, or 

<a>). 

➢ Use appropriate HTML tags to define the purpose and structure of the element 

(e.g., <img> for images, <svg> for scalable vector graphics). 

➢ Assign relevant attributes to the HTML tags to specify the source file, 

dimensions, alt text (for accessibility), and other properties. 

➢ Use relative file paths to link the graphic asset to your HTML file, ensuring 

the file path accurately reflects the location of the graphic asset within your 

project directory. 

▪ CSS Styling (if applicable): 

➢ Open your CSS file in a text editor or web development tool. 

➢ Identify the appropriate CSS selectors for the HTML elements containing 

your graphic assets. 

➢ Apply CSS rules to style and position the graphic assets within the webpage. 

➢ Consider techniques like CSS background images, CSS sprites, or responsive 

design principles to optimize the display and responsiveness of your graphic 

assets across different devices and screen sizes. 

▪ Upload Graphic Assets: 

➢ Transfer your graphic assets, including the original files and any optimized 

versions, to your web server or hosting platform. 

➢ Ensure the file structure on the server matches the file structure in your project 

directory to maintain consistent file paths. 

▪ Test and Refine: 

➢ Open your webpage in a web browser to preview and test the integration of 

your graphic assets. 

➢ Check for any rendering issues, responsiveness problems, or broken links. 

➢ Make adjustments to the HTML markup, CSS styling, or file paths as 

necessary to ensure proper display and functionality of your graphic assets. 
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By following these steps, you can seamlessly integrate your graphic assets into your 

webpages, adding visual appeal and enhancing the overall user experience. Regularly test 

and optimize your assets to ensure optimal performance and compatibility across different 

browsers and devices. 
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Self-Check Sheet 3: Use objects to HTML 
 

 

1. When exporting objects for the web, which file format is commonly used for images that 

contain complex graphics and gradients?  

a) JPEG   b) PNG   c) GIF    d) SVG 

2. Which file format is suitable for images that require transparency, such as logos or icons?  

a) JPEG   b) PNG   c) GIF    d) SVG 

3. Which file format supports animation and is commonly used for displaying short, looping 

animations on the web?  

a) JPEG   b) PNG   c) GIF    d) SVG 

4. When integrating graphic assets into webpages, which HTML element is commonly used to 

display an image?  

a) <image>   b) <picture>   c) <img>   d) <asset> 

5. Which attribute is used in the <img> tag to specify the source (URL or file path) of the image? 

a) src    b) alt    c) href    d) url 

6. Which attribute is used in the <img> tag to provide alternative text for the image, useful for 

accessibility and SEO purposes?  

a) src    b) alt    c) href    d) url 

7. When integrating graphic assets into webpages, which CSS property is commonly used to 

control the size of an image?  

a) width   b) height   c) size    d) scale 

8. Which CSS property is used to position an image within its containing element?  

a) align   b) position   c) float    d) display 

9. Which CSS property can be used to apply a background image to an element?  

a) background-image   b) image-source  

c) background-url   d) image-background 

10. When integrating graphic assets into webpages, which file format is commonly used for 

scalable vector graphics?  

a) JPEG   b) PNG   c) GIF    d) SVG 
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Answer Key 3: Use objects to HTML 

Answer: 

 

1. Answer: b) PNG:  

2. Answer: b) PNG 

3. Answer: c) GIF 

4. Answer: c) <img> 

5. Answer: a) src 

6. Answer: b) alt 

7. Answer: a) width 

8. Answer: c) float 

9. Answer: a) background-image 

10. Answer: d) SVG 
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Job Sheet 3: Use objects to HTML to build a website 
 

Job Name: Use Objects to HTML to build a website. 

 

Procedure: 

Step 1: Use Job Sheets 1 & 2 for elements and slices. 

Step 2: Create HTML Structure 

Step 3: Convert Objects to HTML 

Step 4: Apply CSS Styling 

 

Sample Image: 
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Specification Sheet- 3: Use objects to HTML 
 

Necessary tools and equipment 

 

Sl. No Name of Tools & Equipment Specification Unit Quantity 

1 Computer 
Minimum Corei3 with 

4GB RAM 
Set 01 

2 
Web Browser (e.g., Google 

Chrome) 
Latest Version No. 01 

3 Internet connections  High Speed Set 01 

4 

Image processing software 

(e.g., Adobe Photoshop, 

GIMP) 

Latest Version No. 1 

5 
Design software (e.g., Adobe 

XD, Figma, Sketch) 
Latest Version No. 1 

6 
Any HTML/CSS editor (e.g., 

VSCode, etc) 
Latest Version No 1 

Other Specifications: 

 

1. HTML Conversion Approach: 

- Direct Conversion: Text and image objects will be directly converted to HTML 

elements. 

 

2. HTML Structure: 

- HTML File Name: index.html 

- Basic HTML Skeleton: <!DOCTYPE html>, <html>, <head>, <title>, <meta>, and 

<body> tags. 

 

3. Objects for Conversion: 

- Text Elements: <p>, <h1>-<h6>, <span> tags. 

- Image Elements: <img> tags with src and alt attributes. 

- Interactive Elements: <a>, <button>, <input>, and other appropriate tags. 

 

4. CSS Styling: 

- CSS File Name: styles.css 

- Styles: Define styles for all HTML elements, including colors, fonts, layout, and 

responsiveness. 
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Review of Competency 
 

Below is your assessment rating for module Perform Design to HTML 

 

Assessment of Performance Criteria Yes No 

Image processing software is identified.    

Basic shape is created.  
  

Image manipulation is performed.   

Web UI (User Interface) is created.   

Graphic design object is identified.   

Image processing software is selected.    

Smart objects vs normal layers are introduced.    

Layers are used.   

Objects are sliced.   

Objects are exported for web.    

Graphic assets are integrated to webpage.  
  

 

 

 

I now feel ready to undertake my formal competency assessment. 

 

 

 

Signed: 

 

Date: 
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Development of CBLM: 
 

The Competency Based Learning Material (CBLM) of ‘Perform Design to HTML’ 

(Occupation: Web Design, Level-3) for National Skills Certificate is developed by NSDA with 

the assistance of SIMEC System, ECF consultancy & SIMEC Institute JV (Joint Venture Firm) 

in the month of June 2023 under the contract number of package SD-9A dated 07th May 2023. 
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